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OpenRoads Designer - Creating Cut Sheets 

P-6-1: Creating Cross Section Sheets – Named Boundaries 

Return to Index 

Before you begin – Creating ORD Cross Section Cut Sheets - Video 

Additional tasks:  P-6-1A – E, create existing features, e-row, env, create corridors, p-row, p-utilities, p-drainage, xs detail, End 
Area Volumes.   

Attach Reference Files – Display Information to be Sectioned 

Open ORD to the NHDOT Workspace and the project’s WorkSet.  Open/create the 12345-XSections.dgn. 

With the Default model active, Reference file attach the Combined.dgn with live nesting set to 1.  Next, attach all other dgn files 
that you want to section over.  E-Terrain or E-MX-Survey-Terrain, E-MX-Survey-Linear, E-Drainage, E-ENV, E-ROW-Lines, E-
Terrain-Rock, E-Utility, Geometry, P-Cor, P-Drainage, P-Utilities, P-Drives, Earthwork, P-Guardrail-Platforms, P-ROW all with live 
nesting set to 0.  As you accept through each drawings attachment make sure you see the message that the Default-3D models 
are automatically being attached.  Do not include point feature drawings such as the E-MX-Survey-Points as those features are 
represented in the XS Detail drawings. 

View both the Default and Default-3D models by Right Clicking and holding to get the popup menu and select View Control > 
Views Plan/3D.  Set the Default-3D view active by clicking on the top of the view.  The content of the cross sections is determined 
by what is displayed in this View/Model.  Shut off Communication Nodes, Electrical Nodes, Gas and Water nodes.  Update the 
view, Save Settings and Save the dgn.  This will be the Cross Section seed file. 

Copy the XS Seed and Attach the appropriate XS Detail 

Copy/Rename the seed to 12345-XSect-RoadName.dgn.  Add the RoadName.  With the Default view active, attach the appropriate 
12345-XS-Detail-RoadName.dgn.  Save Settings and Save the file, repeat for each road as needed.  

https://engage.bentley.com/newhampshire-dot-resources/training/new-hampshire-cross-section-cutsheets
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Create named Boundaries 

The cross sections are generated through Named Boundaries.  The cross 
section boundaries are 3D elements.  Ensure you have 2 views open, a view 
of the Default (2D model) and the Default-3D model.  With View 1 active, use 
the OpenRoads Modeling Workflow’s Drawing Production tab and select the 
Place Named Boundary tool.  Select the cross section image in the top of the 
tool.  Set the drawing seed from the dropdown, this 
should fill in many of the properties in the tool box.  If a 
previous Group of sections were created, you can add 
to the group by selecting it from the group dropdown.  
Otherwise, you are being prompted to Identify a Path 
Element to create boundaries along.  The Name will 
take on the name of the Feature that you select.  The 
offsets, interval, clearance(s), can be changed but are 
set for NHDOT standards.   

Check the Create Drawing and Show Dialog boxes then 
accept through the on cursor prompts to create the 
Named Boundaries.  The Boundaries will be placed in 
both 2D and 3D views and the create drawing box will 
display. 

Create the Drawings 

The Create Drawing box is filled in per NHDOT 
standard setup.  Decide whether to have the drawings 
added to the sheet index or not and hit OK to create the 
Cross Section drawing and sheet model!  The progress 
bar in the lower right will display your progress.  Be 
Patient.  The last Cross Section sheet will be displayed 
when finished.  
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Review and add Additional Annotation 

In the previous step the NH XS Preferences Annotation Group was used to annotate the drawings, and much was annotated.  
From existing features to the ROW and ENV feature to the proposed offset and elevations of the roadway features and the cross 
slopes.  Additional annotation groups label the NH XS Detail features, NH XS Barrier as well as XS EAV Anno for Earthwork 
material if that information has been generated. 

Re-Annotating Sections After Changes 

When changes are made to Corridors and other dgns that are referenced to the cross sections or other reference files attached 
their 3D models will be updated when the sections are opened.  The annotation will not be. 

Using the OpenRoads Modeling Workflow > Drawing Production tab > Annotations pane select the Model Annotation dropdown 
and select Remove Model Annotation.  Check the box for all drawing models and accept.  This will remove all annotation from the 
sections.  You will have to then re-annotate the sections using each Annotation Group.  Start with the NH XS Preferences, then 
NH XS Detail, NH XS Barrier if any is present and finally the XS EAV Anno if that has been done.  Alternately a group called NH 
All can be used that will annotate all the features, but it takes quite a bit of time to run.  The annotate NH All does not include the 
EAV box. 

After you select a group and accept the command, a box showing the Annotate Progress Form will appear.  Move your cursor into 
the box to keep it on top so you can see the progress.  If it gets hidden and you start the next command, it may crash or not finish 
annotating the sections. 

Editing Annotation Groups - Changing Top Frame Annotations 

The cross sections are set up to annotate a list of features contained in the annotation groups.  To edit the list, make the Default 
View active.  Open the Explorer’s OpenRoads Standards Tab, Expand Standards and then select the drawing name.  Right click 
on it, then select Update Standards From dgnlib.  This will update the Annotation Group entries to the latest definitions.   

Next open the Annotation group used to modify the point annotation list.  Expand the > Drawing Name > Annotation Groups > 
Cross Sections > Drawing > NH XS Preferences (or NH All).  Right Click and select Manage.   Alternately select the annotation 
group and in the Properties pane select the Annotation List and click on the … button.  This will bring up the annotation Group for 
editing.  The entry for XS Top Frame controls the list of points that are annotated with offset and elevation across the top of the 
section.  Select XS Top Frame.  This will display Row list and Row Properties which shows the Location list of points to be 
annotated.  Click on the Add filter button above the Expression to alter the list. 
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Highlight an entry and then click on Remove to remove it from the list or Scroll to the Bottom of the list and click in the blank box 
to add a new entry.  The old list was an exclusion list meaning it Added all points on the Top line and the entries told it what not to 
annotate.  This new list is an inclusion list meaning whatever is in the list will be annotated.  Entries should use the OR setting.  As 
a minimum the Road Trav Way, Shldr Edge of Pave, Slope Ditch Front and Toe features should be labeled.  All others can be 
removed.  When done, click Apply Expression Changes to save the list then the X to close the box.  After editing the Offset Row 
the Z or elevation list should be edited to match the same point list entries. 

The Annotation Group Entries are used in more than one group.  If you update the NH All group point list the NH XS Preferences 
will be updated also as it has the same entries for the XS Top Frame. 
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Editing Annotation Groups – Changing Slope Annotation Segments 

As above, to edit the annotation group in Explorer, Expand the > Drawing Name 
> Annotation Groups > Cross Sections > Drawing > NH XS Preferences (or NH 
All).  Right Click and select Manage.  There are 2 entries for Slope annotation, 
XS Left (& Right) Slope Annotation.  Select one of them and then click in the 
Location box and then the … button that appears.  The 3 expressions control the 
selection of points confining them to top line points on the left or right side of the 
CL.  These should not need to be modified.  At the top is a dropdown set to > 
Create list of Segments, the list of segments is at the bottom of the box and can 
be changed by clicking on the box to the right Select Segments from Template.   

At the top of the Select Segments box - use the dropdown 
to select a template.  This will fill in the list of available 
points.  Entries in the bottom left can be selected and then 
using the arrow will copy them to the list of segments.  
Alternately the Point 1 and Point 2 can be selected from 
the dropdown lists and the green + will add the segment 
to the list.  

Different Templates can be used to seed the point list so 
the segment list can be created for a variety of Templates.  

 

 

 

Close the Select Segments box when done and then Apply Expression Changes and close the filter to save it. 

 

Remember to open a section Drawing model, Remove the model annotation and then Reannotate all the sections to see the 
changes you made to the Group.  
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End Area Volumes 

Cut and fill volumes are created in the Cross Section dgn.  Workflow OpenRoads Modeling 
> Home tab Model Analysis and Reporting pane >  select Civil Analysis dropdown Create 
Cut and Fill Volumes.  Next Use the Create End Area Volumes report tool from the 
dropdown.  The Volumes report can be saved for quantity calculations.  The EAV boxes are 
added by selecting Model Annotation from the Drawing production tab and selecting the 
XS EAV Anno C-F group.  A different group, XS EAV Anno C-F-R-M can be used if Muck 
and or Rock is present on the sections.  Check the All Drawing Models box.  

Entries for Rock or Muck removal can be found in the Volumes Report.  They are not 
automatically filled into the annotation box and must be edited by hand. 
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P-6-1A: Create Features of ENV and ROW Elements 

Return to Index 

Before you begin 

This process can take place once you have an existing terrain model as well as delineated wetlands or existing row lines drawn.  
The intent of this process is to featurize and assign elevations to elements that need to be labeled on the cross sections. 

 

Attach Reference Files 

Open/Create the drawing to be worked on, the 12345-E-ENV, E-ROW-Lines or P-ROW. 

View both the Default and Default-3D models by Right Clicking and holding to get the popup menu and select View Control > 
Views Plan/3D.  Set the Default view active by clicking on the top of the view.  Reference file attach the Combined.dgn with Live 
Nesting set to 1.  Fit View. 

Next Reference File Attach the drawing containing the MicroStation elements to be featurized.  Live nesting should be set to 0 
when attaching the env, erl, or prw files from the Prj directory.  In Level Display, turn off all levels in the reference file.  Next Turn 
on only levels that need to be annotated on the Cross sections.  In the Reference file Dialog box select the reference file.  Use 
Tools > Merge into Master and then click in the view to copy all the elements displayed into the dgn and automatically detach the 
dgn file. 

Save Settings and Save the dgn.  Use File > Open to re-open the dgn.  This will make some of the 3D elements from the attached 
reference files visible in the Default view that were previously not displayed. 
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Create Features from Elements 

1. Use element selector and select all elements in the drawing by clicking on Select All.  
Expand the extended settings by clicking on the triangle at the right if not already 
expanded, use the level tab to display levels with elements in them.  Next unselect all but 
one level.  Start with isolating the top level first and progress through each in turn.  

2. In the Feature Definition toggle bar Set 
the use active feature button on the left 
and select the linear feature definition 
for the elements selected.  Use the 
Create Civil Rule Feature tool from 
OpenRoads Modeling workflow, 
Geometry tab’s, General Tools, Design 
Elements, drop down menu.  

3. Data point in 
the view to 
create the 
features.  

 

 

 

4. With the features still selected use the Profile From Surface tool in the Vertical group of 
the Geometry tools to attach elevations to the new features.  Data point on the screen to 
Profile the selected elements, next Select the Existing terrain model by clicking on it. 
(do not right click to use active terrain model as this can cause problems when the features 
are imported and no terrain is active).  Accept through the rest of the prompts as displayed 
to the right to attach elevations to the features.  

Repeat steps 1 – 4 on each level containing elements.   
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P-6-1B: XS Detail Tick Features for Section Annotation 

Cross section detail tick features are created from point features that are deemed relevant to appear on the 
cross sections.  They include trees, poles, hydrants and such.  A point feature station offset elevation report 
is run on the 12345-E-MX-Survey-Topo.dgn’s point features as well as an alignment xyz report to get the 
information for a macro which draws tick mark elements at the 50 foot stations.  These tick marks are 
featurized and profiled over the terrain model to assign elevations.  A separate dgn should be created for 
each Alignment for the tick features to be included in the XS drawing for that Alignment. 

Note: in newer project the E-Detail.dgn contains cells, not point features – use the Survey-Topo.dgn for the 
report. 

DGN setup 

Open the 12345-XS-Detail.dgn's Default model.  Check that the Combined.dgn is attached with live nesting 
1 to see the project’s existing detail drawings.  Reference File Attach the 12345-Geometry.dgn file (no 
nesting) as well as the ….\OpenRoads\Survey\12345-E-MX-Survey-Topo.dgn that contains the point features.  Save settings, 
Save the dgn and reopen it.  Set the existing terrain model Active. 

Using only the Default model view, shut off all reference files that don’t have point features, except the 12345-Geometry.dgn's 
Default Model. Also shut off the Default-3D model reference.  The view should now only show the Geometry and the E-MX-Survey-
Topo Default models. Save Settings and Save the dgn.  This file will be the Seed detail file.  Continue by Copying/Save As this file 
as 12345-XS-Detail-RoadName.dgn 

Create Alignment Report 

If a 50' interval alignment report in .XLS format already exists, skip this section and continue to create the detail station & offset 
report.  Select the Horizontal Geometry Report button that is found on either the Analysis & Reporting or the Horizontal Geometry 
Task menus. 

Follow the Heads-Up prompt and select the alignment (in the Default View) associated with the cross sections you wish to annotate.  
Click the Right Mouse (Reset) button to complete the selection process. 

Confirm that the boxes on the Horizontal Geometry Reports panel for Lock to Start, Lock to End and Interval are all checked.  Set 
the Interval value to 50. 
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If your alignment does not start at an even 50 value, uncheck the Lock to Start box and enter a 
start station that is at an even 50 foot value. 

The last prompt looks for Profile information.  This report does not need to have vertical 
information, so any response for this prompt will suffice.  If there is interest in other reports 
beyond the scope of this procedure, then specify Active Profile so that the vertical component 
is included. 

OpenRoads will open the Bentley Civil Report Browser and display the default horizontal report.  
This browser offers many predefined report options on the left side of the panel.  The right side 
of this panel displays the output of the selected report option.  From the left side of the report 
window, select the HorizontalAlignmentIntervalXYZ.xsl report. 

The report must have the correct station format before saving.  Tools > Format options > 
Stations should be set to SS+SS.SS   Direction should be ddd^mm^ss.  When the report is 
displayed, select Save As... from the File menu and select the Microsoft Excel option.  Provide 
a File name.   

Create Station/Offset Detail Report 

Use Element selector and drag a box around all the point features to be reported in the project area selecting them.   Note that 
only features which typically appear on cross sections will be processed.  

Once the point features are selected, choose the Point Feature Station Offset Elevation Report tool from the OpenRoads Modeling 
Workflow - Model Analysis & Reporting tab - Reports Dropdown. You will be prompted to click on the alignment (select it in the 
Default view) and then data point to accept the selected detail features. When the default report appears, change the report to 
StationOffsetNorthingEastingElevationFeature.xsl. Use the Save As option on the File menu of the report window to save this 
report as an Excel (*.xlsx) file.  Open the report to check its contents. 

Create Cross-Section Detail Features 

Once the reports are created, the next step is to create a series of lines at the even 50' station which is nearest to each detail 
feature. If not already, Open the 12345-XS-Detail-roadname.dgn, Default model that was created to contain these detail 
lines.  Creating separate drawings for each alignment's detail ticks (by using the File > Save As command). 
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To create cross section detail features in OpenRoads Designer, set the workflow to Drawing 
> Utilities tab > Macros pane select XSDetail macro from the drop down menu then click Play. 
Select the detail and alignment xlsx files created in the previous steps. Click Apply if you plan 
to do another alignment after or OK if this will be the only one processed.  The macro creates 
short line segments offset at each 50-foot station.   

 

1. Use Element Selector to select everything in the drawing.  Switch to the Element 
Templates tab of the element selector.  Click (or click and drag) on each to deselect 
all templates except one, leaving only it selected.  

2. Next use the Feature Definition Toggle bar drop down list, expand Linear > XS Detail 
> and set the feature to match the selection and turn on the Use Active Feature toggle 
button. 

3. Use the Create Civil Rule Feature tool from the Geometry tab’s General Tools pane 
> Design Elements dropdown list to set the feature definition and Accept.  The 
selected lines should now be features of the type that is active. 
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4. The features are in the Default model.  In order for them to show up on the cross 
sections, they will need elevations.  Use the Geometry tab’s Vertical pane’s Profile 
Creation dropdown tool Profile from Surface to attach elevations to the features.  Make 
sure the feature definition is still defined and the elements still selected from the 
previous step.  Accept through the prompts and Right click to use the active Terrain 
model when asked.   

 

The names of the features can be 
annotated on the cross sections.  
Attach the 12345etxt.dgn for tree 
sizes and descriptions.  The Point 
Feature Station Offset Elevation 
Report created earlier will provide 
the + station of the features. 

Use Element Selector to select 
each tick and edit the name in 
Element Information to include the 
+ station value for all features.  Pole 
numbers, tree sizes and 
descriptions are not required on the 
sections. 
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P-6-1C: Cross Section Earthwork Features 

Creating Cross Section Earthwork Features 

Cross Section Earthwork features include Topsoil, Pavement Removal, Unsuitable Materials as well as Limited Reuse Soils which 
are delimited with a 2D outline that is used to create clipped terrain models.  The depths will be created with surface templates. 
Muck and Rock will also fall into this category but are dealt with somewhat differently. 

 

This information will be stored in the 12345-Earthwork.dgn. Note that references to "12345" in file names refer to the project's five-
digit Project Number. 

 

Create Earthwork Feature Boundaries 

First, the area to be computed needs to be delineated as a closed 2D shape.  Set the level to the feature you are going to delineate. 
The level names are Strata - followed by the type. 

Use the Fill Area Boundary created previously and any other elements to create closed areas/shapes for the features needed.  For 
example, use Element Selector and select the Fill boundary, drive edges and the existing edge of pavement. 

Use the Create Region tool to delineate Topsoil removal areas. Set the fill type to Flood (the left most icon at the top of the panel) 
and check the box to Keep Original. 

To define areas of pavement to be removed, a color plan or the hearing plan can be attached as a reference. The Fill area boundary 
and the edge of pavement features can be used to determine the area of pavement to be removed. 

After all the shapes are defined, use the Terrain Modeling task Create Clipped Terrain Model to create a separate clipped terrain 
model for each area.  Use the NH_Prop_Earthwork Feature Definition under the Terrain Display features and set the Feature 
Name to reflect the area and location as shown below. 
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Apply Surface Template 

A Surface Template needs to be applied to each clipped terrain to define the material and depth.  See the chart below.  If a different 
depth of material is needed Open the template editor, Copy the desired template, rename it and re-specify the depths below the 
origin. 

Topsoil removal depth and any unsuitable material should be defined in the geotechnical report.  Existing pavement depths may 
be found in the pavement recommendation or from the borings or straight-line diagrams. Areas of differing depths should be 
defined separately and a different depth template assigned.  Drives usually only have 2 or 3 inches of pavement vs. the roadway 
possibly having 5 or more. 

 

Earthwork Summary Sheet Description 

Terrain Name * 

Template Name 

2A Bituminous Pavement in Fill Sections Earth - Pavement x" Exist Pave 

8 Topsoil Removed Beneath Fill Sections Earth - Topsoil x" Topsoil 

9 Unsuitable Material Removed Beneath Fill Sections Earth - Unsuitable x" Unsuitable 

Limited Reuse Soils LRS Earth - LRS Unsuitable 18" LRS Unsuitable 

* A description can be added to clarify areas.  For example, 

Earth - Pavement - LT Sta 21+00 - 22+25 
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P-6-1D: Rock Excavation Quantities 

Introduction 

A set of 25’ sections is created and sent to Materials & Research for Rock line interpolation.  Sheets are returned to design and 
scanned.  Lines are drawn in plan view at each section location and the profile displayed.  The scanned files are referenced into 
each Profile View of the section location traced and set active.  Create a terrain model from all sections.  Then apply a surface 
template. 

Create Sections for Materials & Research 

Create Rock Terrain 

Create/Apply Earthwork Surface Template 

After the Rock terrain model has been created, review the Dynamic sections to determine the greatest depth of rock removal.  
Create a new Surface template with the components vertical depth that is greater than the largest rock removal depth.  Set the 
Feature definition to Mesh\XS Components\Strata – Rock.  This Feature definition should have the Volume Option set to Substrata. 

In the Earthwork.dgn file’s Default model reference in the Rock Terrain.dgn.  
Open the Default-3D model.  

OpenRoads Modeling workflow > Model Detailing Tab > Create Closed Mesh 
tool to create a mesh for rock calculations to be done on. 

In the XSections.dgn file attach the Earthwork dgn file as well as the Rock 
Terrain.dgn file.  The Civil analysis tool Compute cut and fill volumes is used.  
When it finishes, use the Create End Area Volume Report.  The report will show 
the total Rock which can be ignored…. As well as the Strata-Rock (Removed) 
which is what you want to annotate onto the sections EAV table cell. 

  

https://nhgov.sharepoint.com/sites/DOT-ProjectCentral-Home/SitePages/Create-Rock-Surface-from-Sections.aspx
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P-6-1E: Skewed Drive Sections (and Profiles) 

Introduction 

Creating skewed drive sections is a process that includes creating horizontal and vertical geometry, adding extra named 
boundaries to create sections as well as displaying and referencing the skewed drive profiles into those sections.  The process 
can be done by adding the additional sections into the main group or by creating a new group of just the drives. 

Open the Drives.dgn’s Default model and reference the Combined.dgn with live nesting 1, the Geometry and Corridor dgns with 
no nesting.  Adjust Level Display so that no Default-3D Levels or Models are displayed other than the Terrain’s.   

Create the Drive’s Horizontal Geometry 

Skewed Drives should be created by elements with a tangent perpendicular from the Mainline alignment out to the P_EP and then 
skewing along the drive. 

Use the OpenRoads Modeling Workflow Geometry Tab Horizontal > Geometry Pane > Place Line Between Points command.  
Use Feature Definition Alignment Elements.  Select 2 points along the CL of the drive in the skewed area.  Use the Trim to Element 
command to extend this line back to the Corridor’s EP.  Place Line Between Points and set the snap mode to Perpendicular.  
Select the Mainline alignment and slide the tangent back and forth ensuring it’s perpendicular and then snap to the skewed line’s 
endpoint on the EP. 

In the feature definition Toggle bar set Alignment Drive and use the Create Complex tool to join the pieces and create the connected 
drive geometry.  If the drive is in a cut section a reference line (Feature = Construction Control) 7’ over at the slope of the shoulder 
from the EP can be created using the Single Offset partial command and then the Profile by Slope from Element.  Rename the 
created drive feature adding the approximate station and side for identification purposes. 

Create the Drive’s Vertical Geometry 

Right Click in the default view and hold until the pop-up menu displays.  Move into the View Control menu and select Views Plan/ 
Profile/3D.  OK.  When asked, hit on the Drive alignment in the Default view then the bottom view to display the profile in it.  In 
View Attributes the view’s Exaggeration can be modified from the Default 10 to 1 so the profile looks more like a section for easier 
viewing.  

In the Profile View, Select Create 3D Cut. Full and click in the profile view to display the cut of the 3D model. Snaps will be turned 
off in the referenced Cut graphics.  In Level Display Select and right click on the referenced Drive’s Default-3D model and turn 
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Snaps on by checking it.  From the Profile Creation menu select the Profile Intersection Point command.  Select the Drive and 
then the Edge of Pavement element and a point should appear on the profile at the location of the feature showing the location of 
the drive’s intersection elevation point. 

Set the Feature Definition to Elements Alignment again and create the drive profile from elements starting with Lines.  The drive 
profile should start at the EP of the corridor using a Origin Point snap on the intersection point.  Back in the profile view select the 
Line command again and you should be able to snap to Corridor’s EP.  If the drive is in a cut, define the second point using an 
Origin Snap selecting the Construction Control cell that was placed or set the length and slope to the next point.  Adjacent Drive 
Slopes should not exceed a 10% algebraic difference in grades of lengths not less than 10’ generally.  Place the next line from the 
previous one with a Key Point snap at its end and set the length and slope of the next tangent.  Use the Right arrow key to switch 
between them and lock the entries by hitting the Enter key.  Continue until the profile matches in, the last tangent section can be 
Trimmed to Element to meet the existing ground.  Change the Feature Definition to Alignment Drive and use Complex Geometry 
by Elements to link the pieces together.  Select the connected profile and set it active.  The drive should now be displayed in the 
3D view.  
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Create Drive Profile Drawing for Xsection Reference 

Review the cross section that was cut at the Drive location 
and determine the height of the section as well as the Top 
Clearance used. 

With the drive’s profile view active, use OpenRoads 
Modeling workflow > tab Drawing Production, then Select 
the Place Named Boundary tool.   

• Drawing seed (none), Detail Scale 1”=10’ 

• the profile should be named for its mainline station 
value and side.   

• Start station set to 0. 

• Stop location set to 1+00 for 10 scale sections set 
vertical. 

• Vertical Exaggeration to 1 

• Top Clearance to match the sections (typically 14). 

• Available Profile Height can be limited to 40’.   

Accept through the prompts to create the named 
boundary and bring up the create drawing box. 

Fill in the Create Drawing box as shown.  Click OK when 
done to create the drawing. 

Save Settings and Save. 

Open the Drawing model just created and shut off all the 
levels in the active model leaving the levels from the 
reference file turned on.  Plot a skewed drive cell. 
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Place a Drive Civil Cell and Manipulate It 

After placing the drive civil cell, click on Create 3D Cut to display the driveways select materials in the profile view. 

Create a Station Offset Report from the Mainline Alignment to each Drive 

Set the workflow to OpenRoads Modeling > Home tab > Model Analysis pane, select Reports > Station Offset Report.  Select the 
roadway alignment and then click on each driveway alignment Reset to complete and have the report show up.  Save this report.  
Each drive’s profile can also be reported on and saved. 

Open Cross Sections drawing model and reference in the Drive Profile 

Open the Cross Section dgn file and then open the drawing model associated to the drive section.  Reference file Attach the drive 
profile with live nesting 99.  Proposed and existing levels can be turned off for the actual section which may not follow the drives 
skew.  This information can be clipped out of the sections drawing models reference file.  Also shut off the drives profile elevations.  

 

  

P-6-1F: Controlling Displayed information on the Cross Sections 

Introduction 

The various reference files contain the base information that is displayed on the sections and the cross section annotation groups 
control what is annotated on the sections.  Other information from reference files is used to generate the End Area Volumes and 
the Volumes report for quantities but is not needed to be displayed on the finished cross section plots for the contractor.  It may 
be beneficial to Create a Saved View of the display status so it can be used when annotation needs to be updated as well as one 
to globally shut the levels back off. 

Global Display 

Global display is used to turn off levels that you don’t want displayed on the cross sections.  Simply turning off the display of levels 
in the Default-3D model is not sufficient to turn them off in the actual sections.  The Global Display of levels can be achieved thru 
the Level Manager or thru the Level Display tools.   
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Construction Plan Check List – for Cross Sections  

Review the Construction Plan check list for a list of what should be displayed on the sections.  Right click on the screen to open 
the View Control menu and select 2 Views Plan/3D.  This will display both Default and Default-3D models.  Make the Default-3D 
active.  Using the Level Display change the Type from View Display to Global Display.  Next shut off levels that don’t need to be 
displayed. 

Corridor and drive dgn files can have their base courses shut off so only the Top and Bottom meshes are displayed.  The 
EarthWork.dgn can have all of its levels shut off.  All survey point features can be turned off.  In the XSections.dgn all of the 
Volumes- levels can be turned off. 

 

When done updating the levels state, save Settings and then Save the dgn.  Create a Saved View for future use to recall the 
Global display settings if the annotation was redone and levels were turned back on.  To ensure that the changes make it to all the 
sheets it is suggested that the dgn is closed and reopened before printing. 

 

 

 

 

 

 


